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Introduction 
Welcome to MainBoss Advanced 3.0 

 
This guide provides a quick introduction to principles of using MainBoss Advanced 3.0. 
 

� For information on installing or setting up the software, see the Installation and 
Administration Guide 

� For details of MainBoss set-up, see Configuration Quick-Start or the full 
Configuration guide 

� For information about day-to-day use, see Operations Quick-Start or the full 
Operations guide 

 
What You See 

Here’s a typical picture of the program’s main window: 
 

 
 

On the left is the control panel. This provides access to all standard actions and 
information. On the right, the Refresh button updates the information displayed (in case 
other users have recently made changes to your organization’s data). 
 

General Principle: In MainBoss Advanced, you use the control panel (on the left) to 
go to a table, then you use the table’s buttons (on the right) to do work. 
 

This manual uses the notation Entry | Subentry to refer to items in the control panel. 
For example, Work Orders | Reports refers to Reports under the Work Orders entry 
in the control panel. 
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Whenever you select an entry in the control panel, the rest of the window changes to 
show information about what you selected. For example, if you click Work Orders in 
the panel, the right-hand part of the window changes to show information on work 
orders. 
 

We recommend that you maximize the main window so that MainBoss has the most 
possible screen-space to display information. 
 

Keyboard Shortcuts: MainBoss allows standard Windows keyboard shortcuts such as 
<Ctrl+C> for copy and <Ctrl+V> for paste. You can also use <Tab> to move to the 
next field in a window; if you’re filling out a form, you can just tab from one field to 
another rather than using the mouse. <Shift+Tab> moves backward to the previous 
field. 
 

MainBoss buttons often allow keyboard shortcuts. To see the shortcuts, press the <Alt> 
key. One letter of the button will be underlined, as in Save. Pressing <Alt> plus the 
underlined letter is equivalent to clicking the button, so that <Alt+S> is equivalent to 
clicking the Save button. 
 

View Options: The View menu provides options that control how information is 
displayed: 
 

� Zoom in on View: If you click this menu item, MainBoss will hide the control 
panel in this window. If you were looking at a table viewer, you will see an enlarged 
version of the View section (without any other of the table viewer’s sections). If you 
were looking at a report window, you will see all sections of the window. 
 

When you are zoomed in like this, Zoom in on View will be marked with a 
checkmark in the View menu. To “zoom out” again, click Zoom in on View again. 
This returns to the window’s usual appearance. 

� Open in New Window: If you select this option, MainBoss opens a new window 
containing the same information as the current one. This is useful if you want to 
compare information between tables: have two windows open, one showing one 
table and one showing the other. 

 
Getting Help 

There are several ways to obtain online help while using MainBoss: 
 

� Pressing the <F1> function key displays information about the window currently on 
the screen. 

� If you point the mouse to something on the screen, MainBoss displays a tool-tip (a 
small yellow message) providing information about what you’re pointing at. This is 
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particularly useful if a button on the screen is currently disabled (i.e. grayed out). 
The tool-tip explains why the button isn’t currently available. 

� The MainBoss Help menu provides access to MainBoss’s help files. 

� Help → Contents gives you the table of contents for the help files. 
� Help → Help Index gives you an index of important terms. 

 
Specifying Your MainBoss Database 

The first time you start MainBoss, you must specify how to connect with your 
MainBoss database. 
___________________________________________________________  

 

� To set up MainBoss so that it can access an existing database: 

1. Log in to the computer under your usual login name. 

2. Start MainBoss on the new machine. It will display a window asking you to specify 
the maintenance organization (database): 
 

 
3. Click Add Existing Organization. This opens a window like this: 

 

 
4. In “OrganizationName”, enter a name that will let you recognize this database. 

5. In “DataBaseServer” and “DataBaseName”, enter the names given to you by the 
person who’s in charge of MainBoss at your site. (These names tell MainBoss how 
to find the appropriate database.) 
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6. Click OK. MainBoss will add the database name to the list. You’ll see something 
like this: 
 

 
7. Click on the line containing the maintenance organization name, then click Set 

Start Default. (This means that MainBoss will use this maintenance organization 
whenever it starts up.) 

8. Click Open Organization. 

___________________________________________________________  
 

Once you have set up this computer to access the maintenance organization, you don’t 
have to do it again. Every time you start MainBoss on this computer, it will 
automatically start working with the specified database. 

 
Table Viewers 

A table is a list of entries, each of which contains information about something. For 
example, the Vendors table is a list of your suppliers. 
 

Each entry in a table is called a record. For example, each entry in the Vendors table 
gives information about one of your suppliers. 
 

A table viewer lists the records in a particular table. For example, the Vendors table 
viewer lists the entries in your Vendors table. 
 

Table viewers usually have two sections: 
 

View: A list of normal records—this can be anything from work orders to 
information about spare parts. 

Defaults: Default values for creating new records. For example, the default values 
in the Vendors viewer will be used whenever you create a new vendor record. 
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Deleted Records 

In the bottom right hand corner of most table viewers and editor windows, you’ll see 
either Active or All: 
 

� If the word is Active, lists of records displayed in the window only include active 
records. This means that the window only shows records that haven’t been deleted.  
This situation is shown in the preceding picture. (Note that in rare cases, deleted 
records sometimes have to be shown in order to display undeleted ones). 

� If the word is All, the viewer is showing all records including those that have been 
deleted. Deleted records are marked with a red X on the left. 
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In most tables, MainBoss never completely erases deleted records. This makes it 
possible to maintain a complete audit trail of everything you do. 
 

To switch from Active to All or vice versa, double-click the word. You’ll see deleted 
records appear or disappear. 
 

The Restore button lets you “undelete” a selected record. MainBoss opens a window 
where you can examine the record to be restored and make changes if necessary. When 
you save the record and close the window (typically by using Save & Close), the record 
will be restored to the active list. 
 

Records That Refer to Deleted Information: When you delete a record, it’s possible 
that other records still refer to it. For example, suppose a worker leaves your 
organization so you delete that person from your Employees list. That worker’s name 
will still appear in old records (e.g. work orders that the person worked on). 
 

MainBoss indicates that data comes from a deleted record by striking out the data. For 
example, if you delete Joe Smith’s employee record, all work orders that refer to that 
person will show the name as Joe Smith. This shows that the associated employee 
record has been deleted (and will reduce your confusion when you can’t find Joe 
Smith’s name in your list of Active employees). 

 
Editors 

An editor is a window where you can enter information. Most editor windows have a 
Details section where you can enter basic information; many editor windows have more 
sections for additional information. 
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� Mandatory fields are marked with a red arrow until they’re filled in. You can’t save 
the record until you specify values for those fields. (In the picture below, 
“Requestor” and “Subject” are mandatory.) 

 
 

� Read-only fields can’t be changed. They can be recognized because they are not 
surrounded by a black border line. In the picture above, several fields are read-only. 
For example, “Business Phone” is read-only. (As soon as you specify a 
“Requestor”, MainBoss looks up the person’s phone number from your Contacts 
table and displays the result.) 

� As shown above, editor windows have several buttons containing the word Save: 

Save: Just saves information you’ve entered. 

Save & Close: Saves the information and closes the window. 

Save & New: Saves the information and starts a new record. This lets you create 
one record after another; for example, if you’re recording contact information 
for people, you can Save & New after each person, which saves what you’ve 
just entered and starts a record for someone else. (Fields in the new record are 
initialized with default values as set in the Defaults section of the appropriate 
table viewer.) 

Save & Print: Saves the information and opens a window that will let you print the 
record you’ve just created. 

General Tip: When you’re filling out a record, if you don’t know what value a field 
should have, leave it blank. Filling in dubious values will cause confusion down the 
line, and finding values that need to be changed can be difficult. If MainBoss really 
needs a field to be filled in, it uses the red arrow to make the field as mandatory. 
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Drop-Down Lists (Pickers) 

Editor windows often specify information using drop-down lists, also known as pickers. 
For example, the “Requestor” field in a work request editor is a drop-down list: 
 

 
 

As shown above, a drop-down list ends with three symbols: 
 

� The left-most arrow displays a list of available values for the field. In the case of 
“Requestor” this will be a list of the people whom you’ve authorized to submit 
work requests. 

 
 

� The “...” opens a window showing the complete table. For example, if you click the 
“...” for “Requestor”, you get the Requestors table. Click an entry in the table, then 
click Select to fill in the original field. 

- 8 - 



 
 

� The right-most arrow of the drop-down list opens a menu that gives you a number 
of options. For example, if you click this arrow for the “Requestor” field, you’ll see 
the following: 
 

 

Browse lets you look at the existing Requestors table, just like the “...” button. 
New Requestor lets you create a new requestor record; if you do this, the requestor 
will be filled into the original “Requestor” field once you save and close the new 
record. This makes it easy to create new records “on the fly” if you don’t already 
have an appropriate record. 

If you want to delete (clear) the value that’s currently shown in this kind of field, right-
click on the field and choose Clear. (With drop-down lists, the Clear option only 
shows up in non-mandatory fields; you can’t clear the value of a mandatory drop-down 
list once it’s been given a value, although you can give the field a different value.) 

 
Errors 

MainBoss puts a marker beside data fields that contain invalid data. The error marker is 
a red circle containing a white exclamation point. This is shown below, where the 
“Effective Date” field should contain a date, but instead contains meaningless text: 
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If you try to save a record when it contains an invalid field, MainBoss will display an 
error message and won’t save the record. 
 

To find out why a data value is invalid, move your cursor to the error marker. MainBoss 
will display a tooltip with a message explaining why the current value can’t be 
accepted. This is shown below: 
 

 

 
Concurrency Errors 

In the rare case that two people try to edit the same record at the same time, MainBoss 
will report a concurrency error. 
 

For example, suppose you start editing a Units table record and before you’re done, 
someone else tries to edit the same record. The first person to save the record will 
succeed. The second person to save the record will receive an error message indicating 
that the record has changed while you were making your changes: 
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MainBoss is asking you to resolve conflicts between the changes that were just made. 
The error message lists the fields in the record. For each field, there are three columns: 
 

� The first column shows the record’s values at the time you began editing 

� The second column shows what the values are now (the ones that the other person 
saved) 

� The third column shows the new values you’ve specified yourself 

Where the values are different, you can see fields where your values differed from the 
other person’s. The Next Conflict and Previous Conflict buttons jump to fields where 
the values conflict. 
 

In many records, some field values will look like nonsense strings of characters. These 
strings are actually links to other tables. For example, the “Unit Contact” field refers to 
an entry in the Contacts list. The field’s value is a meaningless character string that 
serves as a pointer. You can see if two pointers have the same value, but you can’t tell 
anything about the record they point to. 
 

When conflicts occur, it’s best to click the No button on every conflict; this basically 
says, “Ignore what I just did.” ) Then just go back and start editing the record again. 
This time you’ll see the values that the other person put in. You can then decide which 
of these you want to change. 

 
Interrelated Records 

MainBoss records are often linked to each other. For example, a record describing a 
piece of equipment might have a link to a service contract record, indicating that the 
equipment is covered by the service contract. This link is roughly analogous to a link on 
a web page: it’s a pointer that MainBoss can follow in order to find related information. 
 

If record A links to record B, record B often links back to record A. For example, just as 
an equipment record can link to a service contract, each service contract record has 
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links to all the units covered by the contract. This makes it possible for MainBoss to go 
from equipment to service contracts or vice versa. 
 

Now suppose you’re creating a new unit record and you go to the Service Contracts 
section. If you haven’t yet saved the unit record, you’ll see that the New button in the 
Service Contracts section is disabled. Why? Because the unit record doesn’t exist until 
you save it. If you tried to create a new service contract record before the unit record 
was saved, there’d be nothing to link the service contract back to. 
 

For this reason, the New button for service contracts stays disabled until you save the 
unit record. After that, the New button is enabled and you can use it to create a new 
service contract. 
 

Note that if you hold the cursor on the disabled New button, a tooltip will explain the 
situation. 
 

If this seems confusing, just remember this rule: If you’re in the middle of creating a 
new record, MainBoss may not let you create a connected record until you save the 
first record. 
 

If you find that a New button is deactivated, saving the current record will usually 
activate the button. 

 
Corrections 

Some editors have a Correct button as well as an Edit button. Correct is used to make 
corrections to information that has already generated accounting transactions (e.g. 
records of actual costs on work orders). To maintain an accurate audit trail, MainBoss 
doesn’t let you change or delete existing accounting records. Instead, you have to create 
new “correction” records which add or subtract from previous monetary values. 
 

On a similar principle, “physical count” records resulting from taking inventory can’t 
have their numbers altered once the record is saved. Instead, you have to “void” 
(cancel) a physical count, then record a new count. Again, the point is to prevent 
numbers from being fudged—you always leave an audit trail. 

 
Reports 

Reports can display and analyze your maintenance information. Many sections in the 
control panel have subsections that offer reports; for example, Work Orders | Reports 
offers you a number of reports dealing with work orders. 
 

When you choose the control panel entry for a report, you get a window that lets you 
specify options for the report: 
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Report Sections 

The window associated with a report organizes options into sections. Different reports 
have different sections, but here are the most common: 
 

Grouping and Sorting: Lets you control how the report is organized. For example, 
suppose you’re printing information on work orders. The report will be divided 
into sections, with each section containing work orders that have something in 
common. For example, each section might refer to a different location (which 
gives you a location-by-location breakdown of the work you do). As another 
example, you might group your information by unit, so that you get a unit-by-
unit breakdown of your work orders. 
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Within each section, you can sort by other criteria. With work orders, for 
example, you can sort by “Start Date” (the date each job began), by “End 
Date” (the date each job ended), by work order number, and so on. 

Filtering: A filter lets you select which records you do and don’t want in the report. 
For example, you might want to restrict a report on units to units in a particular 
category. Filter sections let you specify such restrictions. 
 

The Filtering section lists a number of checkboxes; each is associated with a 
type of information that you can select. When you checkmark one of the boxes, 
MainBoss opens a window where you can specify the information that you want 
included in the report: 

Range of values: If you select Range of values, you can restrict the report to a 
consecutive set of records. 
 

 
 

You specify the start of the range in the “From” line. You can select any 
record or else specify Any value, in which case the report will begin at the 
start of the list. For example, if you’re filtering by work order number and 
you set “From” to WO 00000006, the report will begin with the specified 
work order and continue on from there. If you specify Any value, the 
report will begin with the very first value in the appropriate table. 
 

Similarly, you specify the end of the range in the “To” line. You can select 
any record or else specify Any value, in which case the report will end 
with the end of the list. 
 
If you select the same value in both “From” and “To”, the report will only 
cover the single selected value. For example, if you set both “From” and 
“To” to WO 00000006, the report will only give you information about that 
work order. 

Note: In ranges (and lists in general), MainBoss sorts information in textual order, not 
numeric. For example, the value 011 sorts before 10—anything that starts with 0 sorts 
before anything that starts with 1. 
 

Specific values: If you select Specific values, MainBoss gives you a check-list 
of possible values. 
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Checkmark the entries you want to include in the report. 

Enable Filter: Clicking this activates the selection you’ve just made. MainBoss 
closes the filtering window and restricts the report as you specified. When 
you return to the previous window, you’ll see that the filter has been 
checkmarked. 

Disable Filter: Clicking this de-activates an existing selection. MainBoss closes 
the filtering window and removes any associated restrictions on the report. 
When you return to the previous window, you’ll see that the filter has been 
marked as blank. 

Advanced: Lets you specify a title for the report when it is printed. Depending on 
the type of report, this section may also let you specify additional options. 

Preview: Displays a preview of the report—a version of what you’d see if you 
actually printed the report on paper. Preparing such a preview often takes time, 
since MainBoss may have to process a lot of data; therefore, you might have to 
wait while MainBoss creates the preview. (The Preview section is described in 
more detail later in this chapter.) 

 
The Preview Window 

The Preview section of a print window contains a control bar like this: 
 

 
 

This bar contains the following (from left to right): 
 

 

Document Map button: By default, the left side of the Preview section 
contains a “map” of the report. This shows you the report’s sections and the 
contents of each section. If you click the Document Map button, the map 
will disappear; click it again and the map comes back. 

 

If you click an entry in the document map, the preview changes to show you that entry. 

- 15 - 



 First Page button: Goes to the start of the document. 
 

 Previous Page button: Goes to the previous page of the document. 
 

 
Gives the number of the page that is currently being displayed 
and the total number of pages in the report. You can go to a 
specific page by typing the appropriate page number into the box. 

 

 Next Page button: Goes to the next page of the document. 
 

 Last Page button: Goes to the last page of the document. 
 

 
Parent Report button: Goes to the item that contains the currently selected 
item. For example if you’re looking at an item within a section, this button 
goes to the beginning of the containing section. 

 

 
Stop button: Stops processing the report. You might click this you start 
preparing a lengthy report, then change your mind. 

 

 Print button: This is the button that actually prints the report. 
 

 
Print Layout button: Switches the display to “layout” format. This shows you 
a scaled-down version of the page as it will actually print. Click the button 
again and you go back to the normal display format. 

 

 
Page Setup button: Opens a window where you can specify paper size, 
margin size, and other printing information. 

 

 
Export button: Exports information from the report into a file suitable for 
use with some other program. If you click the down-arrow associated with 
this button, you’ll see a list of available export formats. 

 

 

Scale: Controls the scale of information displayed in the 
preview window. For example, if you set the scale to 200%, 
you’ll see the information at twice its normal size. If you set 
the scale to 50%, you’ll see it at half its normal size. 

 

 

Searching: To search for information in the report, 
type what you want to find in the box, then click 
“Find”. For example, if you’re looking at a full 
Units report and want information on a particular 
unit, type the unit name in the box and click 
“Find”. Clicking the associated “Next” button 
goes to the next occurrence of the same text. 
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